ALES WEB TEAM CONTACTS

For support regarding your ALES website, please fill out an ALES WEBSITE Request form or contact a member of the ALES Web Team:

Genevieve Beaulieu
gmb@ualberta.ca
587 414 1514

Brad Grier
bradgrier@ualberta.ca
587 414 1516
Web Tips and Guidelines

Process to launch your website

1. URL / Domain name acquired and linked to the development website
2. (if required) Privacy blocks / passwords enabled to hide development content from Internet
3. Custom modules integrated (Woo Commerce, Monaris, Forms, custom downloads, Maps, etc)
4. Website Editor accounts created from list of CCIDs provided by client. Non-CCID editors are possible, but not recommended.
5. Previously agreed launch content posted and reviewed by client
6. Google Analytics (if required) set up and tested
7. Client sign off on templates and design of website
8. Client trained in Wordpress content management system by ALES web team
9. (if required) Additional training provided for custom modules

What we provide

- Rotators, training, special modules, custom builds
- Shopping carts and storefronts, Forms, Maps and more
- Analytics account will automatically be created and reports sent to you
- Yoast (SEO tool) will be installed and activated
- News and Events tools are available additional training required
- Access to additional training videos for specific features are available
- Preset templates and university approved colours are offered*
- Content writing tips and guidelines

*other colours will be reviewed on a case-by-case basis

Usability Tips

- Limit global navigation items between 4 to 7 items
- Limit the number of child pages to an element between 5 and 9
- Prioritize content for mobile viewing (most important at top to least on bottom)
- Limit the number of images on a page
- Use horizontal images
- Resize images prior to uploading
- Come up with a naming convention for your images (simplify search of database)
- 1 idea per web page (to improve SEO)
- A rotator is good for a homepage however it is not an effective communication tool (initial image seen and subsequent images seldom seen)
- Use the default font and colour settings do not override with custom fonts. The U of A approved font for websites is installed on all wordpress sites
- Use built in headers as opposed to trying to adjust font sizes manually
- Rich text editor has subscript and other options built in use them!
- Consider your audience avoid acronyms and jargon
- U of A and/or ALES logo must be present on sites and positioning must follow U of A standards
Login

Navigate to: https://ales-cms.ales.ualberta.ca/*Your Site Here*/wp-admin/

or the URL of your website + “/wp-admin”

(http://examplesite.ualberta.ca/wp-admin)

Enter your Username and Password.

First.Last and your ALES password
(same one you use to log into your computer).
Website Dashboard

1. Logout and User Profile – use this area to exit the website editing system or to change your user password.
2. Main site commands
3. Pages – this is where you choose to edit or add new pages
4. Media – all images and documents (jpg, gif, pdf, word, etc) are stored in this area
**Editing menu order or structure**

1. Click on Appearance

2. Click on Menus

3. Find the page in the list (pages)

4. Check the box and select the page
5. Click add to menu (it will show up at the bottom of the list on the right hand side (menu structure))

6. drag it to where you would like it to go

7. save menu

8. refresh your live site
Add a new page

Move a page

Hover over the page to move. Click move. The page will now be highlighted with a yellow bar.
Move your mouse pointer to the destination location for the new page. Click the appropriate button to insert the page after the destination page, before the destination page, or make it a subpage of the destination page.

NOTE: This does not add the page to the menu or navigation structure. Altering this page arrangement is only for your ease of use within the editing tools.

Select a page to edit

![Dashboard](image)
Hover over the page name and then click Edit when it appears.
Edit a page
Depending how the page is set up, you will see one of two views.

Simple page layout

This edit interface is the common one used to edit both Simple and Modular pages.
Editor Interface, Uploading and linking to Images and Documents

Add images and documents

Images

Uploading an image or document.
In the edit interface, move the cursor where you’d like the image to appear. Click the Add Media button.

From the Add Media popup window, either drag-and-drop (from your desktop) the image/document or press the ‘Select File’ button and choose the image/document from your computer. The file will be uploaded to the Media Library.

Inserting an image

Once uploaded, the image will be preselected. It’ll have a blue checkmark in the upper right corner.

Press the blue ‘Insert into page’ button in the lower right to insert the image into the content.
If you have an image already in the Media Library, press the Add Media button.

Select the Media Library tab (if it’s not already selected). Then either scroll to your item or use the ‘Search media items...’ box to filter the presented options.

Once selected the image will have a blue checkmark in the upper right corner.

Press the blue ‘Insert into page’ button in the lower right to insert the image into the content.
Image Size and Alignment

Select the image.

At the far right lower corner, select the image alignment.

(2) Left will put the image on the left side and text will wrap on the right.

(3) Size will let you select from a few standard sizes.

(4) Insert into page.
Documents
This description assumes the document has already been uploaded to the Media Library. See the first part of the Images section (above) to review the uploading instructions.

To link text to a PDF or Word doc:

1) Select the text that you want to be the link. Then copy the text (Ctrl+C)
2) Click the ‘Add Media Button’

![Add Media Button](image)

3) Select the Media Library tab (if it’s not already selected). Then either scroll to your item or use the ‘Search media items...’ box to filter the presented options.

![Search media items](image)
4) Click on the document. This will select it and put a blue box/check mark in the upper right corner of the selected document.

5) Then, go immediately to the ‘Title’ box in the attachment details section on the right.

   Paste in the text you copied to your clipboard from step 1 above.

6) Then Press the blue ‘Insert into page’ button to complete linking your document to this content.
**Linking Images to Documents**

To have an image be a hyperlink that opens a related document.

In the editor, click on the picture and click on add media, select the document.

Once you have selected the document, copy the URL (only keep from the /**/your site name here*/wp-content/uploads/sites/48/2018/05/Stavely-Soil-Health-Field-Day.pdf) and exit this screen. Go back to your picture and click on it.
Linking to an Internal Page
To link text to another page on your website, you first highlight the text that will be the link.
Then click the **Insert Link** button to open up the **Add Link interface**.

Click on the **Gear** icon. This will open up the **Link Options** interface.
1. This is the text that will be the link
2. Check this if you want the link to open in a new browser tab
3. If you have many pages and the page you’re looking for is not displayed, type the title of the page or some text that appears within the page; the results will automatically be filtered to match what is typed.
4. The pages that match your search criteria (3). All pages if the search box is blank.
5. Press this to create the link.
Visual editor vs HTML editor

Visual is a What You See is What You Get editor (similar to Word or other online content editors). Text is a raw HTML text editor.

Modular page layout

On a new page (or a page that is not currently using the Modular page layout) select the Page Builder tab in the upper right.
SiteOrigin Editor
We are here to help General Hours Unless specified [below], all IT support staff hours are:

Custom HTML
Website Development

Custom HTML
ALES eLearning

Custom HTML
System Analysts

Custom HTML
AFNS & REES

Custom HTML
HE & RenR Initial

Custom HTML
Faculty Initial

Custom HTML
University of
Editor Menus

File → Edit → Insert → View → Format → Table →

Edit
- Undo
  - Ctrl+Z
- Redo
  - Ctrl+Y
- Cut
  - Ctrl+X
- Copy
  - Ctrl+C
- Paste
  - Ctrl+V
- Paste as text
- Select all
  - Ctrl+A

Insert
- Insert/edit link
- Media
- Special character
  - Horizontal line
- Add Media
- Insert Read More tag
- Page break

Website Development
In addition to the University Sitecore platform, ALES IT offers services for building research, SharePoint sites and web analytics on a case by case basis.

Email us to set up your new site today!
Website Support & Development
In addition to supporting the University System of Maine, ALES IT offers web development support. We offer services for conference, faculty (personal) websites, research, and web analytics. Custom work available on a case-by-case basis. Email us to set up your new website.

Website Manuals
Shows or hides additional features of the editor.

Website Support & Development

In addition to supporting the University Sitecore platform, ALES IT offers:

- **Professor page manual**
- **Sitecore3 Image Dimensions**

Contact us

Genevieve Beaulien or Brad Grier
ALES IT - Web Team

Word count: 73  
Last edited by gmb1 on February 21, 2018 at 9:45 pm

At the bottom of the edit window. Displays last edit detail and current word count.
Screen Options

At the top of the edit window is a tab labeled Screen Options. Clicking it reveals a dropdown that allows you to add or remove various edit components in the Edit Window.
Content Versions or Revisions

In the screen options, check the Revisions checkbox to enable viewing revisions. Here you can review previous versions of this content and, if necessary, revert back to a previous version.
Once you’ve completed reviewing versions, the Return to editor link in the upper left corner will take you back to your content.
Publishing your content

1. Content can be in one of three states:
   a. Published – this content is public and on the Internet
   b. Draft – this content is not yet published
   c. Pending Review – this content is final content, but a website Author, Editor, or Administrator has to review it yet. They have the ability to publish this content.

2. You can also hide final or Published content by editing the visibility of the content.
Create and Edit a Post

To create or edit an item to appear within a content block or blog post, select ADD NEW from either the left-hand menu or the + at the top of the page. The New Post edit window will appear. It’s very similar to the Page Edit window described previously.

1. Enter the title of your item here. In some cases, this will appear in a ‘roll-up’ module on the Home Page / Landing Page. The post URL (permalink) will be automatically generated from the text entered in this title field.
2. This is the main edit area. It functions identically to the Page Edit area described previously.
3. Add images to your main article area. Images are inserted at the cursor point. This functions identically to the Page Edit area described previously.
4. **Categories are important.** On some websites, categories are used to filter which posts are to appear within specific content blocks.
5. Add new category types here.
6. Add a Feature Image here. These are required for images to appear anywhere content is aggregated or rolled-up to be displayed. This includes teaser images for the home page or post excerpts on rollup-pages.

7. Excerpt (REQUIRED) This is a text only field. Bold, Italics, Underscore, Hyperlinks are not allowed here. This is a short ‘teaser’ text that will appear in content blocks next to the Feature Image (teaser image).

8. Set the article author here. It’s not currently displayed on many sites.
9. Save / Publish. Save your draft (without publishing) or schedule your item for publishing. Or publish now.

**View your site**